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NEW QUESTION: 1
An existing triggered send needs to be updated with new content
Select the correct sequence
A. Pause message interaction, Edit message content, Publish changes, Start triggered email interaction
Answer: A (LEAVE A REPLY)

NEW QUESTION: 2
Northern Trail Outfitters is setting up new hires on its instance of Marketing Cloud, which includes Email
Studio, Mobile Connect, and Social Studio. One of the hires needs to manage the operations of all of
the North American Business Units.
What two roles, custom or standard, could be assigned to this user to meet the requirement?
Choose 2 answers
A. Marketing Cloud Regional or Local Administrator
B. Marketing Cloud Email Marketing Manager
C. Marketing Cloud Channel Manager
D. Marketing Cloud Administrator
Answer: C,D (LEAVE A REPLY)

NEW QUESTION: 3
A customer wants to automate the send of a monthly promotional email. The customer will upload an
audience file to their accounts Enhanced FTP on a monthly basis on the 15th day of each month,
expecting the email to be deployed upon completion of the import activity. However, if the 15th of the
month falls on a Saturday or Sunday, the customer will provide the file on the Friday prior to the 15th
and expect the promotional email to be sent on that Friday.
Given the customers' requirements, which method should be used to automate their monthly
promotional email?
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A. Create a scheduled daily automation that includes an import activity and user-initiated send.
B. Create a triggered automation that includes an import activity and user-initiated send.
C. Create a scheduled monthly automation that includes an import activity and triggered send.
D. Create a triggered automation that includes an import activity and triggered send.
Answer: B (LEAVE A REPLY)
Since Time is not fixed, its triggered Automation and User Initiated. Triggered send is used for
transactional message.

NEW QUESTION: 4
A data team wants to automate that sync of subscribers' Unsubscribes and status from their enterprise
account to their external CRM In one consolidated file. They need to find subscribers In their Marketing
Cloud account and their unsubscribe data for child business units.
Which two data views would they use to achieve this?
Choose 2 answers
A. _Complaint
B. _Subscribers
C. _Unsubscribe
D. _BusinessUnitUnsubscribes
Answer: B,D (LEAVE A REPLY)
Explanation
The _Subscribers data view contains information about each subscriber in an account, such as
subscriber key, email address, status, and business unit ID. The _BusinessUnitUnsubscribes data view
contains information about each unsubscribe event for each subscriber in a business unit, such as
subscriber key, business unit ID, and unsubscribe date. By using these two data views, the data team
can find subscribers in their Marketing Cloud account and their unsubscribe data for child business
units. References:
https://help.salesforce.com/articleView?id=sf.mc_as_data_view_subscribers.htm&type=5
https://help.salesforce.com/articleView?id=sf.mc_as_data_view_businessunitunsubscribes.htm&type=5

NEW QUESTION: 5
A customer wants to automate a series of three emails as part of a Membership renewal drip campaign.
* Email #1 will be sent one month prior to the member's renewal date
* Email #2 will be sent one week prior to the member's renewal date
* Email #3 will be sent on the member's renewal date
* A master audience is updated in real time via the API
Which steps should be included in the customer's automation?
A. Import activity -> Three send definitions to the master data extension
B. Three send definitions to the master data extension
C. Three filter activities -> Three send definitions to the filtered audiences
D. Import activity -> Three filter activities -> Three send definitions to the filtered audiences
Answer: C (LEAVE A REPLY)
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NEW QUESTION: 6
Northern Trail Outfitters (NTO) send emails from Content Builder and Journey Builder. When
subscribers reply to an email, NTO would like to send an auto-reply message using a pre-defined HTML
email that explains email replies are unmonitored and they should call NTO for any inquiries.
How could these auto-reply messages be enabled?
A. From the Reply Mail Management settings page, choose the 'Create Custom Response' option under
'Automated Response Email for Remaining Replies' section and select the HTML email from the 'define
email' link.
B. Create a Triggered Send and on the Reply Mail Management settings page, choose the 'Create
Custom Response' option under 'Automated Response Email for Remaining Replies' section, then
select the Triggered Send email.
C. Create a Triggered Send and from a Sender Profile properties page, enable 'Custom Reply Mail
Management Settings', 'Use Auto Reply' and 'Reply using triggered send' options, then select the
Triggered Send email.
D. Open Admin > Account Setting page in Email Studio and in the 'Auto Reply Email' section, select
'Custom' and paste the HTML email code into the text area field.
Answer: (SHOW ANSWER)
Explanation
To send an auto-reply message using a pre-defined HTML email when subscribers reply to an email,
Northern Trail Outfitters should create a triggered send and from a sender profile properties page,
enable 'Custom Reply Mail Management Settings', 'Use Auto Reply' and 'Reply using triggered send'
options, then select the triggered send email. This will allow them to use a custom HTML email as an
auto-reply message instead of a plain text message. References:
https://help.salesforce.com/s/articleView?id=sf.mc_es_reply_mail_management.htm&type=5
https://help.salesforce.com/s/articleView?id=sf.mc_es_create_a_triggered_email_message.htm&type=5

NEW QUESTION: 7
A customer wants to reports on 'Not Sent' contacts in Journey Builder.
Which method should be used?
A. Use the standard report 'Subscribers Not Sent to'.
B. Use an automation with Tracking Extract.
C. Create an Analytics Builder Discover report.
D. Query the _sent Data View for the contact's send status.
Answer: A (LEAVE A REPLY)
Explanation
To report on 'Not Sent' contacts in Journey Builder, Northern Trail Outfitters should use the standard
report
'Subscribers Not Sent to'. This report shows how many contacts were not sent an email due to various
reasons, such as unsubscribes, bounces, duplicates, or errors. References:
https://help.salesforce.com/s/articleView?id=sf.mc_rn_subscribers_not_sent_to_report.htm&type=5
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NEW QUESTION: 8
Northern Trail Outfitters' marketing team is made up of a marketing manager, a marketing specialist,
and a graphic designer. The team is new to Marketing Cloud and has very little coding experience.
Currently, they use Excel and VLOOKUP to segment their email audiences and import them into
Marketing Cloud.
What solution should be recommended to allow for long-term self-sufficiency in segmentation?
A. Data Filters
B. Attribute Groups
C. Publication Lists
D. Query Activities
Answer: A (LEAVE A REPLY)
Explanation
To allow for long-term self-sufficiency in segmentation, Northern Trail Outfitters should use data filters.
Data filters are a user-friendly tool that allows marketers to segment their data based on criteria and
conditions without coding. Data filters can also be refreshed and reused for different campaigns.
Attribute groups are used to link data sources in Contact Builder, not for segmentation. Publication lists
are used to manage opt-in preferences, not for segmentation. Query activities require SQL knowledge
and coding skills, which the marketing team lacks. References:
https://help.salesforce.com/s/articleView?id=sf.mc_es_data_filters.htm&type=5

NEW QUESTION: 9
A marketer wants to create and edit email content, as well as generate reports and manage subscriber
data.
Using the principle of least privilege, which two pre-defined roles should be assigned? (Choose two.)
A. Content Creator
B. Analyst
C. Data Manager
D. Administrator
Answer: (SHOW ANSWER)

NEW QUESTION: 10
Northern Trail Outfitters' account is configured with Multi-Org to leverage two Salesforce CRM accounts.
In the Cloud Kicks business unit they want to disconnect the sandbox instance and connect the
production instance.
What additional configuration changes should they make?
A. Configure Multi-Org settings to account for two production instances in Setup.
B. Rename and delete sandbox synchronized data extensions before connecting.
C. Remove existing user mappings, attribute mappings, and tracking subscriptions.
D. Update query activities that reference the synchronized data extensions.
Answer: D (LEAVE A REPLY)
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Explanation
Before disconnecting the sandbox instance and connecting the production instance in the Cloud Kicks
business unit, NTO should remove any existing user mappings, attribute mappings, and tracking
subscriptions that are associated with the sandbox instance. User mappings define which Marketing
Cloud users can access which Sales Cloud users' data. Attribute mappings define which Sales Cloud
fields are used as subscriber attributes in Marketing Cloud. Tracking subscriptions define which Sales
Cloud objects receive tracking data from Marketing Cloud sends. These settings should be removed
before changing the CRM connection to avoid errors or conflicts. Additionally, NTO should update any
query activities that reference the synchronized data extensions from the sandbox instance, as these
will be different from the production instance synchronized data extensions. References:
https://help.salesforce.com/articleView?
id=sf.mc_co_disconnect_a_salesforce_org_from_a_business_unit.htm&
https://help.salesforce.com/articleView?
id=sf.mc_co_map_marketing_cloud_users_to_salesforce_users.htm&typ
https://help.salesforce.com/articleView?
id=sf.mc_co_create_attribute_mappings_for_your_account.htm&type=5
https://help.salesforce.com/articleView?
id=sf.mc_co_set_up_tracking_information_to_send_to_salesforce.htm&

NEW QUESTION: 11
Northern Trail Outfitters receives data from their point-of-sale system every night. The file is placed on
their Enhanced FTP, but there is not a consistent time or naming convention for the file.
In which two ways should they set up their automation to import the data from the file on a nightly bais?
(Choose 2 answers)
A. %%BASEFILENAME_FROM_TRIGGER%%
B. %%BASEFILENAME_FROM_FILEDROP%%
C. Scheduled Starting Source
D. File Drop Starting Source
Answer: (SHOW ANSWER)
Explanation
This allows you to specify the exact name of the file when running the automation. The File Drop
Starting Source is an automation activity that allows you to specify the source of the File Drop as either
a Scheduled or Manual event. This allows you to control when the data is imported from the Enhanced
FTP file.
To set up their automation to import the data from the file on a nightly basis, Northern Trail Outfitters
should use two ways to start their automation:
File Drop Starting Source. This is a trigger that starts an automation when a file is dropped in an
Enhanced FTP folder or an external SFTP location.
Scheduled Starting Source. This is a trigger that starts an automation at a specified date and time or at
recurring intervals.
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%%BASEFILENAME_FROM_TRIGGER%% and %%BASEFILENAME_FROM_FILEDROP%% are not
starting sources, but variables that can be used in file transfer or import activities to reference file
names.
References: https://help.salesforce.com/s/articleView?
id=sf.mc_as_automation_studio_triggers.htm&type=5

NEW QUESTION: 12
Northern Trail Outfitters sends a monthly loyalty balance email to inform members of their current points
balance. Emails are segmented based on loyalty status, and no segment should contain more than
2500 contacts for any send.
What should be used to prevent emails from being sent if they exceed 2500 contacts7
A. Script Activity
B. Query Activity
C. Verification Activity
D. Stop Activity
Answer: (SHOW ANSWER)
Explanation
A Verification Activity can be used to prevent emails from being sent if they exceed a certain number of
contacts. A Verification Activity checks the number of records in a data extension or list and stops the
automation if the number is above or below a specified threshold. References:
https://help.salesforce.com/s/articleView?id=sf.mc_as_verification_activity.htm&type=5

NEW QUESTION: 13
A customer provides a file containing only new and updated subscriber records exported from its
marketing database.
* The file will be uploaded to the customer's Enhanced FTP automatically at 3 a.m. daily.
* The customer requires that the import completes prior to 4 a.m.
* On average, the file will contain about two million rows of data each day.
Based on the customer's requirements and recommended best practices, how should the daily file be
imported?
A. Import the file into a list, using the 'update only' method.
B. Import the file into a list, using the 'add and update' method.
C. Import the file into a data extension, using the 'add and update' method.
D. Import the file into a data extension, using the 'overwrite' method.
Answer: C (LEAVE A REPLY)
Since Record count in more than 500 K so DE is used. New and Update is already specified in question.

NEW QUESTION: 14
A retail company needs to create journeys that will target subscribers based on website behavior. They
have identified three separate groups:
* Customer who searched for an item on their website
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* Customers who abandoned a cart on their website
* Customers who made a purchase on their website
Which three questions should the consultant ask in order to design the data structure to this solution?
Choose 3 answers:
A. How long after the behavior occurs will a subscriber need to enter a journey?
B. Should a single customer exist in multiple journeys at the same time?
C. How are the subscribers identified in your web analytics?
D. How many messages should be included in each journey?
E. Should customers exit the journey when the goal is met?
Answer: A,B,C (LEAVE A REPLY)

NEW QUESTION: 15
A financial company wans to use Marketing Cloud to send late payment notices to accounts whose
payment due date lapsed the previous week. The company has shared the following:
*Payment.csv will arrive on the Enhanced SFTP each Monday at 1 a.m.
*Payments.csv will be encrypted.
*Payments.csv will contain data from the previous week.
*Late payment notices will be sent each Monday at noon.
*They need to receive a file containing customers who opened or clicked on the late payment notice
email within five days after send.
Which automation sequence represents a viable solution?
A. Import File > File Transfer > SQL Query > Wait > Send Email > Wait > SQL Query > Data Extract >
File Transfer
B. File Transfer > Import File > Filter > Wait > Send Email > Wait > SQL Query > Data Extract > File
Transfer
C. File Transfer > File Transfer > Import File > SQL Query > Wait > Send Email > SQL Query > File
Transfer
D. File Transfer > Import File > Filter > Wait > Send Email > SQL Query > Wait > Data Extract > File
Transfer
Answer: (SHOW ANSWER)

NEW QUESTION: 16
Northern Trail Outfitters wants to create a query to populate a data extension with email subscribers
who belong to a specific publication list.
Which Data View could they use to achieve this?
A. _ListSubscribers
B. _Subscribers
C. _PublicationSubscriber
D. _EnterpriseAttribute
Answer: A (LEAVE A REPLY)
Explanation
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The _ListSubscribers data view contains information about subscribers who belong to a specific list,
including publication lists. It can be used to query subscribers based on their list ID, status, and date
joined or unsubscribed. References:
https://help.salesforce.com/s/articleView?id=sf.mc_as_data_view_listsubscribers.htm&type=5

Valid Marketing-Cloud-Consultant Dumps shared by PrepPdf.com for Helping Passing Marketing-
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NEW QUESTION: 17
A customer wants to reports on 'Not Sent' contacts in Journey Builder.
Which method should be used?
A. Create an Analytics Builder Discover report.
B. Use an automation with Tracking Extract.
C. Use the standard report 'Subscribers Not Sent to'.
D. Query the _sent Data View for the contact's send status.
Answer: C (LEAVE A REPLY)

NEW QUESTION: 18
A customer has an email newsletter to send out, but wants to deliver it with a targeted message for
customers within a specified age range. These data have been defined in attributes from a sign-up
landing page.
How should the customer individualize the email content?
A. Guide Template Language
B. Personalization Strings
C. Dynamic Content Areas
D. Substitution Strings
Answer: C (LEAVE A REPLY)

NEW QUESTION: 19
Northern Trail Outfitters wants to suppress their highly engaged email subscribers (multiple opens and
clicks for a target campaign) from active display campaigns to reduce overall cost and eliminate
unnecessary targeting to the user.
What should be recommended?
A. Google Analytics 360
B. Advertising Studio
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C. Einstein Engagement Scoring
D. Mobile Studio
Answer: C (LEAVE A REPLY)

NEW QUESTION: 20
Northern Trail Outfitters wants to send a welcome email to Contacts when a Contact record is added as
a campaign Member to a 'Loyalty Member' Campaign in Sales Cloud.
Which method should they use to send the email from Marketing Cloud?
A. Create a scheduled Automation with a Query Activity and a Send Email Activity
B. Use Content Builder Send Flow to send the email to the Salesforce Campaign
C. Create a Journey with a Salesforce Campaign entry source and an Email Activity
D. Create a Journey with a Salesforce Data entry source and an Email Activity
Answer: D (LEAVE A REPLY)
Explanation
To send a welcome email to contacts when a contact record is added as a campaign member to a
'Loyalty Member' campaign in Sales Cloud, Northern Trail Outfitters should create a journey with a
Salesforce Data entry source and an email activity. A Salesforce Data entry source allows marketers to
inject contacts into a journey based on changes or events in Sales Cloud objects, such as campaign
members. An email activity allows marketers to send an email message to contacts in a journey.
References:
https://help.salesforce.com/s/articleView?id=sf.mc_jb_salesforce_data_event.htm&type=5
https://help.salesforce.com/s/articleView?id=sf.mc_jb_email.htm&type=5

NEW QUESTION: 21
Northern Trail Outfitters' marketing team is made up of a marketing manager, a marketing specialist,
and a graphic designer. The team is new to Marketing Cloud and has very little coding experience.
Currently, they use Excel and VLOOKUP to segment their email audiences and import them into
Marketing Cloud.
What solution should be recommended to allow for long-term self-sufficiency in segmentation?
A. Attribute Groups
B. Query Activities
C. Data Filters
D. Publication Lists
Answer: C (LEAVE A REPLY)

NEW QUESTION: 22
Northern Trail Outfitters wants to send a weekly coupon campaign. They segment their audience using
data from several data extensions, which results in an audience size of approximately 200,000
subscribers. They want to send a reminder three days later at the subscribers' optimized send time.
What solution should they use?
A. Journey Builder
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B. Automation Studio and Journey Builder
C. Automation Studio
D. Automation Studio and Interaction Builder
Answer: B (LEAVE A REPLY)

NEW QUESTION: 23
Northern Trail Outfitters (NTO) wants email subscribers to adopt their app. They are investigating using
MobileConnect features since over 90% of their subscribers provide a Mobile Phone Number when
registering.
Which three considerations should be made before implementing MobileConnect?
Choose 3 answers
A. Long and Short Codes are not available for all countries.
B. Not all countries are supported by MobileConnect.
C. Inbound messaging only works with local Long or Short Codes.
D. Opting in for messages can only be done via inbound message.
E. NTO would be charged by mobile operators directly for messages.
Answer: B,C,D (LEAVE A REPLY)

NEW QUESTION: 24
A small restaurant franchise wants to implement Marketing Cloud to support their franchise owners. The
corporate office the advertising copy and subscriber list. The owners of franchised stores add a
customized local message to the marketing campaign.
What hierarchy should be recommended?
A. One parent business unit and a child business unit for each franchise owners
B. One business unit.
C. A parent business unit for each franchise owner
D. One parent business unit and a child business unit for franchise owners.
Answer: (SHOW ANSWER)

NEW QUESTION: 25
After implement Marketing Cloud Connect, the customer notices tracking details from Email Studio
initiated sends are not being sent back to Sales Cloud.
Which configuration in Marketing Cloud should the customer verify?
A. Report is saved Standard Salesforce folder.
B. Required profile attributes are property mapped.
C. Sendable data extension is saved in the Salesforce Data Extension folder.
D. Email Address column is included in the report used for sending
Answer: (SHOW ANSWER)
Explanation
To troubleshoot why tracking details from Email Studio initiated sends are not being sent back to Sales
Cloud, Northern Trail Outfitters should verify that required profile attributes are properly mapped.
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Required profile attributes are attributes that are needed for Marketing Cloud Connect to function
properly and sync data between Marketing Cloud and Sales Cloud. These attributes include Email
Address, Subscriber Key, First Name, Last Name, and Full Name. References:
https://help.salesforce.com/s/articleView?
id=sf.mc_co_troubleshoot_marketing_cloud_connect_configuration_is

NEW QUESTION: 26
Northern Trail Outfitters has a file that drops intermittently to their SFTP account. Once this file drops,
they want to be able to have it immediately imported and then segmented to enter a specific journey
depending on the data inside the file.
Which two options would meet these requirements?
Choose 2 answers
A. Scheduled Automation
B. File Drop Automation
C. SQL Query
D. Decision Split
Answer: (SHOW ANSWER)
Explanation
A File Drop Automation can be used to trigger an automation when a file is uploaded to the Marketing
Cloud FTP. A SQL Query can be used to segment the audience based on the data inside the file and
populate a data extension for each segment. The data extensions can then be used as entry sources for
different journeys.
References:
https://help.salesforce.com/s/articleView?id=sf.mc_as_define_a_triggered_automation.htm&type=5
https://help.salesforce.com/s/articleView?id=sf.mc_as_query_activity.htm&type=5

NEW QUESTION: 27
Northern Trail (NTO), a longtime Marketing Cloud customer, has decided to adopt Journey Build to help
with the execution of their marketing programs. NTO does not want to duplicate efforts within the
platform and has asked if they could be using Automation Studio entirely.
Which three tasks would a consultant suggest for using Documentary Builder instead of Automation
Studio?
Choose 3 Answers
A. Building simple segmented campaigns without SQL queries
B. Designing decision logic via an ... user interface.
C. Setting behavior-based goals
D. Processing zipped encrypt
ed files containing subscriber data
E. Creating customer segments from multiple data extensions
Answer: A,B,C (LEAVE A REPLY)
Explanation
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Three tasks that a consultant would suggest for using Journey Builder instead of Automation Studio are:
Building simple segmented campaigns without SQL queries. Journey Builder allows marketers to create
simple segmented campaigns using filters and rules without writing SQL queries. Automation Studio
requires SQL queries for creating complex segments using data extensions.
Designing decision logic via an intuitive user interface. Journey Builder allows marketers to design
decision logic using activities such as decision splits, engagement splits, or random splits via an intuitive
user interface. Automation Studio requires scripting or coding for creating decision logic using activities
such as script activities or verification activities.
Setting behavior-based goals. Journey Builder allows marketers to set behavior-based goals using
criteria such as email opens, clicks, conversions, or custom events. Automation Studio does not have a
feature for setting behavior-based goals.
Processing zipped encrypted files containing subscriber data is a task that a consultant would suggest
for using Automation Studio instead of Journey Builder, as Automation Studio has activities such as file
transfer activities or import file activities that can handle zipped encrypted files. Creating customer
segments from multiple data extensions is a task that a consultant would suggest for using Automation
Studio instead of Journey Builder, as Automation Studio has activities such as query activities or filter
activities that can create customer segments from multiple data extensions. References:
https://help.salesforce.com/s/articleView?id=sf.mc_jb_journey_builder.htm&type=5
https://help.salesforce.com/s/articleView?id=sf.mc_as_automation_studio.htm&type=5

NEW QUESTION: 28
Northern Trail Outfitters (NTO) uses Marketing Cloud to connect with its individual consumers, retailers
and wholesale buyers, and its corporate apparel customers. Marketing Cloud is currently configured
with data extensions containing Store, Order, Product, and Contact information. NTO is in the process
of implementing Data Designer and linking its data extensions.
How should consumers, retailers, and wholesale buyers be defined in Data Designer?
A. Population
B. Many-to-Many Relationship
C. One-to-One Relationship
D. One-to-Many Relationship
Answer: D (LEAVE A REPLY)

NEW QUESTION: 29
If I want to introduce a new line of footwear. I am excluding anyone who does not have shoe as an
attribute listed in their preference center. I plan to send the emails daily. After a short time, I notice many
people updating their preferences, and less emails are going out.
What is the issue causing less emails to go out? Select one.
A. Deliverability issues on account
B. High Watermark if journey builder
C. Email frequency too high
D. Preference center is too strict
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Answer: B (LEAVE A REPLY)

NEW QUESTION: 30
Northern Trail Outfitters wants to provide near real-time data in a 30-day welcome journey.
Which data setup should they use for decision splits?
A. Journey Data queried from main data extension
B. Contact Data Mapped through Salesforce Marketing Cloud Profile Attributes
C. Journey Data using CRM Report Import Activity to Salesforce Data Extension
D. Contact Data using Synchronized Data Sources
Answer: D (LEAVE A REPLY)
Explanation
To provide near real-time data in a 30-day welcome journey, Northern Trail Outfitters should use contact
data using synchronized data sources. This will allow them to access the most up-to-date data from
their CRM system in decision splits and other journey activities. Journey data is static and based on the
entry source data extension, which may not reflect recent changes in CRM. Contact data mapped
through profile attributes or imported from CRM reports may not be as timely or accurate as
synchronized data sources. References:
https://help.salesforce.com/s/articleView?id=sf.mc_co_synchronized_data_sources.htm&type=5
https://help.salesforce.com/s/articleView?id=sf.mc_jb_decision_split.htm&type=5

NEW QUESTION: 31
A company collects subscriptions on its websites. It does the following:
* Compiles that subscription list in a database in the website content Management System (CMS).
* Posts this encrypted list to Marketing Cloud nightly at 11 p.m.
* Uses Marketing Cloud as the database of record.
* Sends up to five emails a week based on subscriber engagement with prior sends.
What automation sequence (excluding waits) should cover these requirements?
A. File Transfer > Import File > Measures > Send Email
B. File Transfer > SQL Query > Measures > Send Email
C. File Transfer > Import File > SQL Query > Send Email
D. File Transfer > Data Extract > Filters > Send Email
Answer: C (LEAVE A REPLY)

Valid Marketing-Cloud-Consultant Dumps shared by PrepPdf.com for Helping Passing Marketing-
Cloud-Consultant Exam! PrepPdf.com now offer the newest Marketing-Cloud-Consultant exam
dumps, the PrepPdf.com Marketing-Cloud-Consultant exam questions have been updated and
answers have been corrected get the newest PrepPdf.com Marketing-Cloud-Consultant dumps
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with Test Engine here: https://www.preppdf.com/Salesforce/Marketing-Cloud-Consultant-prepaway-

exam-dumps.html (161 Q&As Dumps, 40%OFF Special Discount: Exam-Tests)

NEW QUESTION: 32
Northern Trail Outfitters wants to capture dietary preferences for Contacts who have registered for an
upcoming launch event. They have created a data extension of Contacts who have registered for the
event and will send them an SMS message from MobileConnect asking them to reply with their dietary
preference.
When Contact reply to SMS message, the response message will be inserted into a data extension
using AMPscript.
Which two MobileConnect templates should be used to send the SMS message and capture the
responses?
A. Text Response
B. Info Capture
C. Outbound
D. Data Capture
Answer: A,D (LEAVE A REPLY)
Explanation
To send an SMS message and capture the responses in a data extension using AMPscript, Northern
Trail Outfitters should use two MobileConnect templates: Text Response and Data Capture. Text
Response is a template that allows marketers to send a text message to a mobile number and receive a
reply. Data Capture is a template that allows marketers to use AMPscript to insert the reply into a data
extension. References:
https://help.salesforce.com/s/articleView?id=sf.mc_moc_text_response.htm&type=5
https://help.salesforce.com/s/articleView?id=sf.mc_moc_data_capture.htm&type=5

NEW QUESTION: 33
A customer wants to automate the send of a monthly promotional email. The customer will upload an
audience file to their account's Enhanced SFTP on a monthly basis on the 15th day of each month,
expecting the email to be deployed upon completion of the import activity. However, if the 15th of the
month falls on a Saturday or Sunday, the customer will provide the file on the Friday prior to the 15th
and expect the promotional email to be sent on that Friday.
Which method should be used to automate their monthly promotional email?
A. Create a scheduled daily automation which includes an Import File Activity and Send Email Activity.
B. Create a file drop automation which includes an Import File Activity and Send Email Activity.
C. Create a scheduled monthly automation which includes an Import File Activity and triggered send.
D. Create a file drop automation which includes an Import File Activity and triggered send.
Answer: B (LEAVE A REPLY)
Since Time is not fixed, its triggered Automation and User Initiated. Triggered send is used for
transactional message.
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NEW QUESTION: 34
A retail company's database of record resides at a third-party company which also keeps track of
purchase history. Their database only updates once a day where new records can be created and
merged. The database uses the unique identifier "Customer ID".
The company wants to send real-time Welcome emails to newly registered website users who provide
their email address in exchange for getting 10% off their first order, and ensure this send is connected to
"Customer ID" in the database.
Which three key issues should be addressed?
Choose 3 answers
A.Will new users have a "Customer ID"?
B. How will Marketing Cloud and the database synchronize?
C.Will the company need a custom preference center?
D.What publication lists will be used?
E.What will be used as Subscriber Key?
Answer: A,B,E (LEAVE A REPLY)

NEW QUESTION: 35
Which two statements about a database of record are correct? Choose 2 answers
A. It is a centralized storage repository of data about objects or people.
B. It is any data structure in which multiple opt-in statuses can be stored for a subscriber.
C. It is any database containing subscriber data.
D. It is a system in which a subscriber's status is maintained.
Answer: (SHOW ANSWER)

NEW QUESTION: 36
A customer provides a file containing only new and updated subscriber records exported from its
marketing database.
* The file will be uploaded to the customer's Enhanced FTP automatically at 3AM daily.
* The customer requires that the import completes prior to 4AM.
* On average, the file will contain about 2 million rows of data each day.
Based on the customer's requirements and recommended best practices, how should the daily file be
imported?
A. Import the file to a list, using the 'add and update' method.
B. Import the file to a data extension, using the 'add and update' method.
C. Import the file to a data extension, using the 'overwrite' method.
D. Import the file to a list, using the 'update only' method.
Answer: (SHOW ANSWER)

NEW QUESTION: 37
An analytics team wants to get real-time updates on transactional email metrics, specifically Sent and
Not Sent, to ensure they are fulfilling a legal obligation due to the nature of their messages.
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A. Event Notification Service
B. Platform Events API
C. Data View Export with every send
D. Data Retrieves on the Send Object
Answer: A (LEAVE A REPLY)
Explanation
To get real-time updates on transactional email metrics, such as Sent and Not Sent, Northern Trail
Outfitters should use Event Notification Service. Event Notification Service is a feature that allows
marketers to receive real-time notifications of email tracking events via webhooks or APIs. Event
Notification Service can help marketers monitor and troubleshoot transactional email sends and ensure
compliance with legal obligations.
References: https://help.salesforce.com/s/articleView?
id=sf.mc_es_event_notification_service.htm&type=5

NEW QUESTION: 38
A customer is starting a new children's fashion brand and wants to use a dedicated business unit within
their existing Enterprise 2.0 account. They anticipate many of their current Enterprise contacts will
subscribe to the children's brand, however, they want to separate subscriber opt-outs of the Enterprise
and children's brands.
The customer has minimal technical resources available for implementation and support.
What should a consultant recommend to meet these criteria?
A. Select "Use separate 'Subscription Center' for this business unit" in Settings
B. Create attributes for each child business unit in "Profile Management" to record unsubscribes
C. Create a Business Unit Filter in 'All Subscribers' List to record unsubscribes
D. Select "Subscribers will be unsubscribed from this business unity only" in Settings
Answer: D (LEAVE A REPLY)
Explanation
To separate subscriber opt-outs of the Enterprise and children's brands, Northern Trail Outfitters should
select
"Subscribers will be unsubscribed from this business unity only" in Settings for each child business unit.
This will allow subscribers to unsubscribe from one brand without affecting their subscription status for
another brand. References: https://help.salesforce.com/s/articleView?
id=sf.mc_co_business_unit_setup.htm&type=5

NEW QUESTION: 39
A bank wants to send out a series of emails to new customers that open a checking or savings account.
The emails will be used to educate and inform customers regarding their current account and other bank
offerings
* Data for the campaign will be in two data extensions: Customer and New Accounts
* The Customer data extension is currently used for multiple campaigns and is updated at 1:00 a.m.
* The New Accounts data is encrypted and will be placed on the FTP at 10:00 p.m.
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Which automated workflow meets the customer's requirements?
A. A scheduled automation that starts at 12:00 a.m. and executes a File Transfer Activity, Import
Activity, Query Activities, Wait Activity, and Send Email Activity.
B. A scheduled automation that starts at 2:00 a.m. that executes File Transfer Activity, Import Activity,
Query Activity, Wait Activity, and Send Email Activity.
C. A scheduled automation that starts at 2:00 a.m. that executes Data Extract Activity, Import Activity,
Query Activity, Wait Activity, and Send Email Activity.
D. A triggered automation that executes File Transfer Activity, Import Activity, Query Activity, Wait
Activity, and Send Email Activity.
Answer: (SHOW ANSWER)

NEW QUESTION: 40
A customer wants Sales Cloud users to create and send Marketing Cloud emails.
Which two recommendations should the consultant make? Choose 2 answers
A. Each Sales Cloud user should have a System Administrator Profile and a Role at the top of the Role
Hierarchy.
B. The consultant should enable the Create Email feature on the user Profile in Sales Cloud.
C. Each user should have a one-to-one relationship between the Marketing Cloud user and the Sales
Cloud user.
D. The consultant should enable deep linking in the Marketing Cloud Connect configuration.
Answer: C,D (LEAVE A REPLY)

NEW QUESTION: 41
Utilizing journey builder interactions for sending post-purchase communications to customers, what
contact entry mode fits?
A. No re-entry
B. Re-entry anytime
C. Re-entry only after exit
Answer: B (LEAVE A REPLY)

NEW QUESTION: 42
Subscribers are collected on a customer's website whose subscription database of record is Salesforce
Marketing Cloud. The customer sends up to 5 emails per week based on subscriber activity. The list is:
* Compiled in a database in the website Content Management System (CMS).
* Imported into Marketing Cloud nightly at 11 p.m.
What action should be taken if a third party is sending a message for the customer outside of the
Marketing Cloud?
A. Unsubscribes should be synchronized between senders.
B. They will need to integrate with the Marketing Cloud SOAP API.
C. Engagement metrics will be passed into Marketing Cloud.
D. The third-party send list should be pulled from the CMS.
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Answer: B (LEAVE A REPLY)
The right answer is: They will need to integrate with the Marketing Cloud SOAP API.
Because this is what required to meet requirement "Unsubscribes should be synchronized between
senders" as well as "Engagement metrics will be passed into Marketing Cloud. "

NEW QUESTION: 43
Northern Trail Outfitters wants to send a welcome email to Contacts when a Contact record is added as
a campaign Member to a 'Loyalty Member' Campaign in Sales Cloud.
Which method should they use to send the email from Marketing Cloud?
A. Create a Journey with a Salesforce Campaign entry source and an Email Activity
B. Create a Journey with a Salesforce Data entry source and an Email Activity
C. Create a scheduled Automation with a Query Activity and a Send Email Activity
D. Use Content Builder Send Flow to send the email to the Salesforce Campaign
Answer: A (LEAVE A REPLY)

NEW QUESTION: 44
By which three standard methods could contacts be injected into a journey? (Choose three.)
A. Date-Based Event
B. Predictive Intelligence Event
C. Sales / Service Cloud Event
D. Mobile Response Event
E. CloudPages Form Submit Event
Answer: A,C,E (LEAVE A REPLY)

NEW QUESTION: 45
A real estate agency wants to send out a biweekly newsletter with the list of properties for all new
contacts added to a newsletter campaign in their Salesforce CRM. The journey consists of an initial
message with property listings and a follow up to those who have engaged with the content.
The rules around which properties are matched to the contact depend on agent assigned as a contact
owner, other agents who might have interacted with the contact, and contact's property interest. The
data model has a relationship between contact > person account > real estate agent > property objects
and all of those are available in CRM as well as synchronized to Marketing Cloud.
What solution should be recommended for execution efficiency?
A. Use Automation Studio and Salesforce sends with campaign as an audience.
B. Use Automation Studio to prepare personalization data and initiate journey.
C. Use Salesforce Data Event to initiate journey and scripting within emails for personalization logic.
D. Use send from Salesforce CRM and Salesforce report to prepare personalization data.
Answer: B (LEAVE A REPLY)
Explanation
To send out a biweekly newsletter with personalized property listings for new contacts added to a
newsletter campaign in Salesforce CRM, a real estate agency should use Automation Studio to prepare
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personalization data and initiate journey. Automation Studio can run a scheduled automation that
imports new contacts from Salesforce CRM into a data extension, runs query activities to join and filter
property data based on contact criteria, and injects contacts into a journey that sends the newsletter
with personalized content. References:
https://help.salesforce.com/s/articleView?id=sf.mc_as_import_activity.htm&type=5
https://help.salesforce.com/s/articleView?id=sf.mc_as_query_activity.htm&type=5
https://help.salesforce.com/s/articleView?id=sf.mc_jb_journey_builder_audience.htm&type=5

NEW QUESTION: 46
Northern Trail Outfitters (NTO) is the holding company of three subsidiaries: Universal Containers, Ursa
Major Solar, and Cloud Kicks. NTO recently purchased Marketing Cloud and has asked its consultant to
recommend a scalable business unit (BU) hierarchy. They don't plan on executing any marketing
campaigns on behalf of the NTO holding company, but NTO employees would like access to all
subscribers and aggregate reporting. Additionally, each subsidiary business will be regularly running
campaigns and should have their own branding, content, and subscribers.
Which solution should the consultant recommend?
A. One parent BU and two child BUs with their own Sender Authentication Packages.
B. One parent BU with three additional private domains.
C. One parent BU and one child BU
D. One parent BU and three child BUs with their own Sender Authentication Packages.
Answer: (SHOW ANSWER)
Explanation
To recommend a scalable business unit hierarchy for Northern Trail Outfitters and its three subsidiaries,
the consultant should suggest one parent BU and three child BUs with their own Sender Authentication
Packages.
This will allow each subsidiary business to have their own branding, content, and subscribers, as well as
access to aggregate reporting and shared subscribers from the parent BU. Each child BU should have
its own Sender Authentication Package to authenticate its email sends with its own domain and
branding. References:
https://help.salesforce.com/s/articleView?id=sf.mc_co_business_unit_setup.htm&type=5
https://help.salesforce.com/s/articleView?id=sf.mc_es_sender_authentication_package.htm&type=5
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NEW QUESTION: 47
A consultant configured a triggered send definition in Sales Cloud for a customer using Marketing Cloud
Connect, The trigger is on a Custom Object called 'Shipments' and is enabled for Triggered Sends in
Setup.
Which two configuration requirements should be considered when troubleshooting? (Choose 2 answers)
A. The Shipment object is on the Account Related List.
B. There is a Master Detail Relationship from Contact to Shipment.
C. The Shipment object requires a Lookup to Lead or Contact.
D. An Apex Trigger is created on the Shipment object.
Answer: A,D (LEAVE A REPLY)
The Shipment object requires a Lookup to Lead or Contact1. This is because triggered sends can only
be sent to Salesforce contacts, leads, or person accounts when object records are created or updated1.
An Apex Trigger is created on the Shipment object2. This is because a trigger is Apex code that
executes before or after certain operations on an object2, and it can be used to invoke the Marketing
Cloud integration action that triggers the email send3.

NEW QUESTION: 48
Northern Trail Outfitters (NTO) maintains a blog for key outdoor enthusiast influencers to use in sharing
their experiences with NTO equipment and the outdoors. NTO also sends out a weekly email
newsletter, and they want to include links to the latest blog entries as part of the newsletter.
Which two solutions could pull in the RSS feed at the time of send?
Choose 2 answers
A. Dynamic Content
B. AMPscript
C. Personalization Strings
D. External Content
Answer: B,D (LEAVE A REPLY)
Explanation
Two solutions that could pull in the RSS feed at the time of send for Northern Trail Outfitters' weekly
email newsletter are:
AMPscript. AMPscript is a scripting language that can be used to retrieve and display dynamic content
from external sources, such as RSS feeds, in emails.
External Content. External Content is a feature that allows marketers to create blocks of content from
external sources, such as RSS feeds, in Content Builder.
Dynamic Content is not a solution for pulling in RSS feeds, as it is used to display different content
based on subscriber attributes or rules. Personalization Strings are not a solution for pulling in RSS
feeds, as they are used to display subscriber or account information in emails. References:
https://developer.salesforce.com/docs/atlas.en-us.noversion.mc-programmatic-content.meta/mc-
programmatic-co
https://help.salesforce.com/s/articleView?id=sf.mc_ceb_external_content_blocks.htm&type=5
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NEW QUESTION: 49
Northern Trail Outfitters has determined they will initially deploy messaging to email and SMS channels,
but also plan for social advertising. Customer data originates within their point-of-sale system which
communicates to Marketing Cloud in real-time via API. They want to configure their customer data for
long-term cleanliness and maintainability.
Which two best practices should be utilized? (Choose 2 answers)
A. Regularly merge duplicate contacts to keep tracking data accurately.
B. Configure Contact Builder to automatically generate a unique subscriber key.
C. Define the subscriber key as a unique value that does not relate to a specific channel.
D.When using an external database of record, utilize that system's identifier as the contact key.
Answer: A,D (LEAVE A REPLY)

NEW QUESTION: 50
Northern Trail Outfitters (NTO) uses the SAP domain comms.nto.com and has just opened an office in
Australia. They have created a business unit for their new office and want to use the domain
comms.nto.com.au to send emails to their Australian customers.
What would be required to enable sending emails from their new domain without impacting
deliverability?
A. An additional private domain
B. An additional Sender Authentication Package
C. An additional IP address
D. Register the new domain in Setup > From Address Management
Answer: (SHOW ANSWER)

NEW QUESTION: 51
Northern Trail Outfitters (NTO) is using Einstein Content Selection to populate its emails with
personalized product images at send time. Tnese emails typically see high engagement, but because of
the frequency of these emails, a customer could see the same image asset several times within a 2-
week span.
How should NTO marketers ensure there's a limit to the number of timet a particular image asset can be
chosen for a customer?
A. Ask the content team to create more images in order to diversify the asset pool.
B. Set a Fallback Asset.
C. Utilize Einstein Engagement Frequency to send the emails less often.
D. Set Fatigue Rules for the product Asset Classes.
Answer: D (LEAVE A REPLY)
Explanation
The best option for NTO marketers to ensure there is a limit to the number of times a particular image
asset can be chosen for a customer is to set Fatigue Rules for the product Asset Classes. Fatigue rules
allow you to specify the maximum number of times an asset can be chosen for a customer in a given
time period. This ensures that customers do not receive the same asset too often, and that the asset
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pool is diversified. For more information on setting fatigue rules, please see the documentation here:
https://help.salesforce.com/articleView?id=mc_es_dynamic_content_fatigue_rules.htm&type=5.

NEW QUESTION: 52
A customer team wants to retarget subscribers who click on links of key items promoted across email
campaigns. The customer has indicated the following:
* Emails will be built using a custom dynamic template for these messages.
* Links will vary over time and across campaigns.
* Click activity will be cross-referenced with subscribers' regional markets on a master subscriber data
extension.
* Retargeting messages will dynamically populate content based on regional market.
In order for this solution to be viable, which skill set does the customer team need to possess?
A. AMPscript
B. HTML
C. SSJS
D. SQL
Answer: A (LEAVE A REPLY)

NEW QUESTION: 53
Northern Trail Outfitters wants to build an abandoned cart journey which includes a Decision Split that
evaluates if a customer has made a purchase after they enter the journey. Customer data is stored in a
master data extension ans purchase data is stored in a second data extension.
Which two steps should they include to accomplish this journey?
A. Utilize Entry Data on a Decision Split within Journey Builder.
B. Configure activities within Automation Studio to update the purchase data.
C. Create a Data Relationship in Email Studio to relate the two data extensions.
D. Use Data Designer in Contact Builder to relate the two data extensions.
Answer: A,D (LEAVE A REPLY)

NEW QUESTION: 54
Northern Trail Outfitters wants to build an abandoned cart journey which includes a Decision Split that
evaluates if a customer has made a purchase after they enter the journey. Customer data is stored in a
master data extension ans purchase data is stored in a second data extension.
Which two steps should they include to accomplish this journey?
A. Use Data Designer in Contact Builder to relate the two data extensions.
B. Utilize Entry Data on a Decision Split within Journey Builder.
C. Create a Data Relationship in Email Studio to relate the two data extensions.
D. Configure activities within Automation Studio to update the purchase data.
Answer: A,B (LEAVE A REPLY)
Explanation
To build an abandoned cart journey, the two steps Northern Trail Outfitters should include are:
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B). Utilize Entry Data on a Decision Split within Journey Builder: A Decision Split allows for the
evaluation of data that is present at the time a contact enters the journey. This can include data from the
entry source data extension, such as whether a customer has made a purchase.
A). Use Data Designer in Contact Builder to relate the two data extensions: Data Designer allows for the
relationship of two data extensions to be established, allowing for data from one data extension to be
used in another. This will enable the evaluation of purchase data stored in a separate data extension
within the Decision Split.

NEW QUESTION: 55
Which two statements are correct about Send Logging? Choose 2 answers
A. Send Log data extensions are archived automatically based on retention settings.
B. AMPscript can be used to pull data from Send Logs for use within emails.
C. A business unit can support up to three Send Logs.
D. SQL Query Activities can reference Send Logs in combination with system data views.
Answer: (SHOW ANSWER)
Explanation
Send Log data extensions are never archived. Its deleted. A business unit can support only one Send
Log.

NEW QUESTION: 56
A publishing company has presented the following:
* A need to send renewal reminders to customers whose subscriptions expire in 15 days and 7 days.
* A campaign needs to be created and managed by a general marketing user who will not have
administrative rights and who is not technical.
* The customers' expiration date is included in the data file.
What component should the customers' solution include? (Choose three.)
A. Template-based emails
B. Automation Studio
C. Suppression list
D. Triggered Send
E. Data Filter
Answer: A,B,E (LEAVE A REPLY)

NEW QUESTION: 57
Northern Trail Outfitters wants to target all customers who have registered to receive Push Notifications.
Their app uses the Mobile Push SDK.
In which two ways should this segment be created?
A. Using Mobile Studio, create a Mobile Push Filtered List then filter on the MobilePush Demographics
attribute group.
B. Using Automation Studio, query the_MobilePushDemographics Data View and save this to a data
extension.
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C. Using Journey Builder, target the entire customer database then filter using MobilePush
Demographics attribute group.
D. Using Contact Builder, create a Filter Data Extension from AB Contact where there is record in
MobilePush Demographics.
Answer: A,B (LEAVE A REPLY)
Explanation
To target all customers who have registered to receive push notifications, Northern Trail Outfitters can
use two ways to create this segment:
Using Mobile Studio, create a Mobile Push Filtered List then filter on the MobilePush Demographics
attribute group. This is a user-friendly tool that allows marketers to segment their mobile push audience
based on criteria and conditions without coding.
Using Automation Studio, query the _MobilePushDemographics Data View and save this to a data
extension. This is a more advanced tool that allows marketers to segment their mobile push audience
using SQL queries and data views.
Using Journey Builder or Contact Builder are not ways to create segments for mobile push audiences,
as they are used for different purposes. References:
https://help.salesforce.com/s/articleView?id=sf.mc_moc_create_a_filtered_list.htm&type=5
https://help.salesforce.com/s/articleView?id=sf.mc_as_query_activity.htm&type=5
https://help.salesforce.com/s/articleView?
id=sf.mc_as_data_view_mobilepushdemographics.htm&type=5

NEW QUESTION: 58
A Marketing Cloud user needs the email addresses of everyone who unsubscribed from a particular
email send. This user does NOT know SQL and does NOT have access to the Enhanced FTP account.
What functionality should be used to retrieve the necessary data?
A. My Tracking
B. My Reports
C. Tracking Extract
D. Data Views
Answer: A (LEAVE A REPLY)
With my Tracking user can create a list, view in browser or download as an attachment with the
subscribers meeting the criteria

NEW QUESTION: 59
Northern Trail Outfitters recently upgraded their preference center to allow customers to indicate which
products they are interested in and to have the ability to opt up and down in send volume. They would
like to configure the Delivery Options in a Journey Builder Email Activity to take these new data points
into account.
Which two options could allow them to meet the requirement?
Choose 2 answers
A. Auto-Suppression List
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B. Publication List
C. Suppression List
D. Domain Exclusion
Answer: B,C (LEAVE A REPLY)

NEW QUESTION: 60
A financial services customer states that families often share email addresses across multiple checking,
savings, loan, and credit accounts. The customer needs to allow individual accounts to use the same
email address in Marketing Cloud but maintain separate subscriber attributes.
Which component should be discussed with the customer to allow for this use case?
A. Member Record
B. Contact ID
C. Data Extensions
D. Subscriber Key
Answer: (SHOW ANSWER)

NEW QUESTION: 61
Northern Trail Outfitters is having their regional supplier conference and wants to allow attendees to
request event-specific safety notifications, schedule or room changes, and surprise pop-up sessions.
Which solution should they use?
A. Keyword opt in and SMS Messaging
B. Smart Capture and Triggered email messaging
C. CloudPages opt in to Event Journey
D. Existing Email Event Notification Subscription
Answer: A (LEAVE A REPLY)
Explanation
Northern Trail Outfitters should use Keyword opt in and SMS Messaging to allow attendees to request
event-specific safety notifications, schedule or room changes, and surprise pop-up sessions. Smart
Capture and Triggered email messaging, CloudPages opt in to Event Journey, and Existing Email Event
Notification Subscription are not the best solutions for this situation.

Valid Marketing-Cloud-Consultant Dumps shared by PrepPdf.com for Helping Passing Marketing-
Cloud-Consultant Exam! PrepPdf.com now offer the newest Marketing-Cloud-Consultant exam
dumps, the PrepPdf.com Marketing-Cloud-Consultant exam questions have been updated and
answers have been corrected get the newest PrepPdf.com Marketing-Cloud-Consultant dumps
with Test Engine here: https://www.preppdf.com/Salesforce/Marketing-Cloud-Consultant-prepaway-

exam-dumps.html (161 Q&As Dumps, 40%OFF Special Discount: Exam-Tests)

NEW QUESTION: 62
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ABC Company has decided to use Journey builder to launch event-driven lifecycle marketing programs.
This includes personalized interactions with customers with the goal of increasing purchase frequency.
What two pieces of information would help ABC Company achieve this objective? (Choose two.)
A. Last purchase date
B. Channel preference of customers
C. Products purchased from a competitor
D. Number of items per order
Answer: A,B (LEAVE A REPLY)

NEW QUESTION: 63
A consultant wants to trigger an email whenever the status field on the Lead Object changes to Hot,
Tracking data will need to be kept in the sales cloud.
Which three steps should the consultant use in the solution
A. Put a SOAP API in place via the marketing cloud API
B. Enable triggered sends on the Lead object in configuration
C. Create the triggered send definition in the marketing cloud
D.Write an Apex Trigger on the Lead object
E. Create the triggered send definition in the sales cloud
Answer: B,C,D (LEAVE A REPLY)

NEW QUESTION: 64
A customer with limited technical resources has requested assistance in setting up a small email
deployment that the customer will maintain long term. The email will display men's shoes to males in the
audience and women's shoes to females in the audience. The sendable data extension contains a field
with a value of Male or Female.
Which method should a consultant recommended to ensure content is displayed properly within the
email?
A. Dynamic Content Wizard
B. AMPscript conditional against the Gender field
C. AMPscriptLookupRows functions
D. NB Test content type
Answer: A (LEAVE A REPLY)
Since There is limited technical resources otherwise AMPscript is also an option.

NEW QUESTION: 65
Northern Trail Outfitters (NTO) wants to create a relevant audience from a data extension for a daily
send campaign. The audience will change from day-to-day. These emails contain a View As Web Page
link and NTO wants to ensure this will not be broken when the audience is refreshed daily.
What should be used to segment this audience?
A. Use AMPscript inside the email to pull information from a send logging data extension to determine
which content displays based on message context
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B. Use SQL Query to filter the audience into a new data extension that is upserted every day
C. Use exclusion lists for the send - excluding those that already were sent the email
D. Use a SQL Query to filter the audience into a new data extension that is overwritten each day
Answer: (SHOW ANSWER)

NEW QUESTION: 66
A restaurant supply company captures email subscribers and leads through trade shows. They hold a
giveaway at each trade show to entice booth visitors to leave their contact information. In the past, they
have used a fishbowl to capture business cards, but need to update this to an online sweepstakes entry
vehicle displayed on a mounted tablet. Individuals should only be allowed to enter once, and the winner
will be selected randomly. All entrants receive a follow-up email after the trade show asking them to
confirm their opt-in for a monthly newsletter.
Which two components are appropriate for this solution? (Choose two.)
A. Microsite with Web Collect to store entrants on a data extension.
B. Send Email Activity with a link to a subscription center.
C. Data Extension with double opt-in status defined.
D. Microsite with Smart Capture to store entrants on a data extension.
Answer: (SHOW ANSWER)
Web collect works with lists only, not data extensions.

NEW QUESTION: 67
Northern Trail Outfitters has integrated their Marketing Cloud account with their Salesforce sandbox.
In what order should the steps be performed to refresh the sandbox in their integrated account?
A. Disconnect / Refresh / Reconnect / Authenticate / Synchronize
B. Disconnect / Refresh / Reconnect / Synchronize / Authenticate
C. Refresh / Disconnect / Reconnect / Authenticate / Synchronize
D. Refresh / Disconnect / Reconnect / Synchronize / Authenticate
Answer: (SHOW ANSWER)

NEW QUESTION: 68
A customer wants to import the previous 10 years of customer purchase data in their Marketing Cloud
account. Through discovery, it is determined there are over 200 million records they plan to upload via
the REST API, and this volume will continue to grow as the current purchase data is added.
Which two questions should be asked for further discovery?
Choose 2 answers
A. Does their License include support for REST APIs?
B.Why do they require 10 years of historical data in Marketing Cloud?
C. How many API calls are included in their License?
D. Does their License include the Large Data Extensions feature?
Answer: (SHOW ANSWER)
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NEW QUESTION: 69
A customer wants to use Sales Cloud as a system of record for email messages sent from Marketing
Cloud; however, the customer only sends from custom objects and cannot use the Contact ID or Lead
ID as the Contact Key in Marketing Cloud.
What is the implication of this data model when using Marketing Cloud Connect?
A. The customer will be able to use Reports and Campaigns as audiences.
B. The customer will be unable to use synchronized data extensions.
C. Tracking Data will not be returned to the Sales Cloud email recipient.
D. Email Sends will fail if the Contact ID or Lead ID is not included.
Answer: D (LEAVE A REPLY)

NEW QUESTION: 70
Northern Trail Outfitters recently purchased Marketing Cloud to start running cross-channel campaigns.
They are looking for guidance on which value to use as the subscriber key.
Which two options should the consultant recommend? (Choose 2 answers)
A. Email
B. Mobile Device ID
C. CRM ID
D. Loyalty Program Number
Answer: A,D (LEAVE A REPLY)

NEW QUESTION: 71
An analytics team wants to get hourly updates on email metrics (send, open, click) to provide timely next
best actions to the sales team.
What method should the team use?
A. Scheduled Reports
B. Tracking Extracts
C. Data views
D. Send Logs
Answer: (SHOW ANSWER)

NEW QUESTION: 72
Northern Trail Outfitters (NTO) wants to send out a communication to subscribers who have not made a
purchase the last six months. Customer are often opted-in to more than one messaging channel. NTO
would like to be able to communicate the same message across all channels.
Which flow would meet their needs?
A. Import Activity > Decision > Journey Activities
B. Salesforce Entry Event > Query Activity > Automation Studio Activities
C. Query Activity > API Event > Automation Studio Activities
D. Query Activity > Data Extension Entry Source > Journey Activates
Answer: D (LEAVE A REPLY)
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NEW QUESTION: 73
To fuel their expansion, ABC Company recently acquired Eagle Outfitters (EO). There is currently a
thirty percent overlap between the guests of each brand and they will be pursuing cross-marketing
opportunities. It was recommended that their Marketing Cloud account now include a separate business
unit for EO and the company secure a new sender authentication package for EO using the private
domain e-EO.com.
Select the statement that correctly describes the implication of this recommendation. (Choose two.)
A. The private domain, e-EO.com, will be used for all link wrapping, image URLs, and landing page
URLs.
B. The EO business unit can also have the ABC Company authentication package applied
simultaneously for cross-marketing emails.
C. The e-EO.com domain will act as the from address for the emails and authenticate using SPF,
SenderID, and DKIM authentication.
D. The email headers for EO will still reflect the private domain for ABC Company since that is the
parent company.
E. The IP address included in the sender authentication package will have the same reputation as the
ones being used for ABC Company.
Answer: A,C (LEAVE A REPLY)

NEW QUESTION: 74
A customer is collecting data from a Smart Capture form that stores submissions in a data extension.
The customer wants an email sent to the marketing manager each morning that contains the previous
day's submissions as a CSV attachment. Assuming that the customer has the attachments feature
enabled.
Which automation workflow will accomplish this?
A. Scheduled Automation: SQL Query > Data Extract > Transfer File > Send Email
B. Triggered Automation: Data Extract > SQL Query > Transfer File > Send Email
C. Scheduled Automation: Data Extract > SQL Query > Transfer File > Send Email
D. Triggered Automation: SQL Query > Data Extract > Transfer File > Send Email
Answer: A (LEAVE A REPLY)

NEW QUESTION: 75
ABC Company wants to better understand subscriber behavior on their website upon arrival via an
email message. A local member of a Marketing Cloud user group mentioned the Web Analytics
Connector.
Which benefit is offered by installing the Web Analytics Connector in a Marketing Cloud account?
(Choose three.)
A. Recognize web traffic as originating from email instead of another channel.
B. Track web activity from a click on an email URL back to a specific email campaign.
C. Match subscribers to web activity by passing Subscriber ID through email links.
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D. Use the web analytics platform to trigger behavioral remarketing emails.
E. Pass web conversion data back into Marketing Cloud for use in email reporting.
Answer: A,B,C (LEAVE A REPLY)
Explanation/Reference:

NEW QUESTION: 76
Northern Trail Outfitters (NTO) maintains a blog for key outdoor enthusiast influencers to use in sharing
their experiences with NTO equipment and the outdoors. NTO also sends out a weekly email
newsletter, and they want to include links to the latest blog entries as part of the newsletter.
Which two solutions could pull in the RSS feed at the time of send?
Choose 2 answers
A. External Content
B. Dynamic Content
C. Personalization Strings
D. AMPscript
Answer: (SHOW ANSWER)

Valid Marketing-Cloud-Consultant Dumps shared by PrepPdf.com for Helping Passing Marketing-
Cloud-Consultant Exam! PrepPdf.com now offer the newest Marketing-Cloud-Consultant exam
dumps, the PrepPdf.com Marketing-Cloud-Consultant exam questions have been updated and
answers have been corrected get the newest PrepPdf.com Marketing-Cloud-Consultant dumps
with Test Engine here: https://www.preppdf.com/Salesforce/Marketing-Cloud-Consultant-prepaway-

exam-dumps.html (161 Q&As Dumps, 40%OFF Special Discount: Exam-Tests)

NEW QUESTION: 77
A customer team wants to retarget subscribers who click on links of key items promoted across email
campaigns. Click activity will be cross-referenced with subscribers' regional markets on a master
subscriber data extension.
What skill set should the customer team have for this solution to be viable?
A. AMPscript
B. SQL
C. SSJS
D. HTML
Answer: C (LEAVE A REPLY)

NEW QUESTION: 78
A customer wants to perform an email send to a subset of a Synchronized Data Extension filtered on
custom object data and return tracking to the Sales Cloud.
What approach should the consultant recommend?
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Choose 2 answers
A. Use Data Filters or Query Activities to output a Sendable Salesforce Data Extension.
B. Use Query Activities to create a Sendable Synchronized Data Extension.
C. Use Data Filters to segment data to output a Sendable Data Extension
D. Use Data Stream to sync Sales Cloud objects to the Marketing Cloud.
Answer: (SHOW ANSWER)

NEW QUESTION: 79
What storage model should be used if a subscriber has more than one value for an attribute?
A. Profile Attribute
B. Data Extensions
C. Lists
D. Publication Lists
Answer: B (LEAVE A REPLY)
The answer should be data extensions because we can create data relationships using data extension.

NEW QUESTION: 80
NTO wants not only to send to their best customers, but also those most likely to buy.
What data will be helpful to send out an email which increases purchase frequency? Choose All that
apply
A. last purchase date
B. conversion rate
C. lifetime purchase value
D. proximity to store
Answer: A,B,C (LEAVE A REPLY)

NEW QUESTION: 81
Northern Trail Outfitters wants to include a 'view online' link in an email template to enable users to view
a web page version of the email.
Which personalization string should they include as the href attribute in the link?
A. %%view_as_webpage%%
B. %%view_email_url%%
C. %%vawp%%
D. %%view_online%%
Answer: B (LEAVE A REPLY)
Explanation
This personalization string is used to direct a subscriber to a web version of the email, allowing them to
view the email online even if their email client does not support HTML. For more information on
personalization strings, please see the documentation here: https://help.salesforce.com/articleView?
id=mc_es_personalization_strings.htm&type=5.
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The %%view_email_url%% personalization string is a system-generated link that allows subscribers to
view a web page version of an email. It can be included as the href attribute in a 'view online' link in an
email template to enable users to view the email in a browser if they have trouble viewing it in their
email client. The
%%view_as_webpage%% personalization string is deprecated and should not be used. The %%vawp%
% personalization string is an alias for %%view_as_webpage%% and should not be used either. The
%%view_online%% personalization string does not exist. References:
https://help.salesforce.com/articleView?id=sf.mc_es_view_email_url_personalization_string.htm&type=5
https://help.salesforce.com/articleView?
id=sf.mc_es_view_as_web_page_personalization_string.htm&type=5

NEW QUESTION: 82
A customer will provide a single daily file on the Marketing Cloud SFTP at 3 AM and needs an alert if the
file is not present on time. The file needs to be:
* Imported into a staging data extension.
* Separated into two different data extensions.
Which workflow should meet these requirements?
A. File Drop Automation: Import File Activity > SQL Query Activity 1 > SQL Query Activity 2
B. Scheduled Automation: File Transfer Activity > Import File Activity > SQL Query Activity 1 > SQL
Query Activity 2
C. Scheduled Automation: Import File Activity > SQL Query Activity 1 > SQL Query Activity 2
D. File Drop Automation: File Transfer Activity > Import File Activity > Filter Activity > SQL Query Activity
1
Answer: (SHOW ANSWER)
No file transfer required because there is no file encryption required.

NEW QUESTION: 83
A consultant explains how a sending domain differs from a customer's primary domain. The customer is
evaluating their options around configuring their domain.
Which two questions should their IT team be asked?
Choose 2 answers
A.Will they be able to post Marketing Cloud-provided DNS files when self-hosting?
B. Does their company allow delegation of subdomains to third parties?
C. Are they able to modify their domain configuration's DNS entries?
D. Can they provide access for Marketing Cloud to update the DNS records?
Answer: B,C (LEAVE A REPLY)

NEW QUESTION: 84
Northern Trail Outfitters has a customer login page on their website and wants to use Marketing Cloud
to send an email to customers who need to reset their password. The email needs to be sent as quickly
as possible.
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Their web server should receive a notification when the email is sent.
Which solution should they use?
A. Transactional Messaging API
B. Single Send journey with an API Event entry source
C. Triggered Send Definition
D. Multi-Step journey with an API Event entry source
Answer: C (LEAVE A REPLY)

NEW QUESTION: 85
An analytics team wants to get hourly updates on email metrics (send, open, click) to provide timely next
best actions to the sales team.
What method should the team use?
A. Send Logs
B. Data views
C. Tracking Extracts
D. Scheduled Reports
Answer: B (LEAVE A REPLY)
Explanation
Data views are system-generated tables that store information about subscriber actions, such as sends,
opens, clicks, bounces, etc. Data views can be queried using SQL statements in automation studio or
query studio to retrieve email metrics for analysis and reporting purposes. Data views store data for up
to six months (or longer for some tables), and can be queried as frequently as needed, such as hourly
or daily. References:
https://help.salesforce.com/articleView?id=sf.mc_as_data_views.htm&type=5

NEW QUESTION: 86
Northern Trail Outfitters (NTO):
* Employs Email Specialists responsible for creating content, testing, sending emails, defining the
activities for Automation Studio, and creating automations.
* Prefers NOT to use custom roles unless it is absolutely necessary.
How should a consultant create and assign roles for NTO?
A. Create a custom Email Specialist role with needed permissions and assign it to the Email Specialists.
B. Check "Allow" automation permissions for the Content Creator Role and assign it to the Business
Units.
C. Check "Allow" automation permissions for the Content Creator Role and assign it to the Email
Specialists.
D. Alter the roles of Content Creator and Data Manager by denying permissions and then assign the
roles to the Email Specialists.
Answer: C (LEAVE A REPLY)

NEW QUESTION: 87
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The customer has these requirements for storing engagement data in their data warehouse:
* All email open and click activity must be pulled daily from the Marketing Cloud.
* Output files must meet the specific requirements for the data warehouse.
* All the activity must be provided via FTP in one file.
Which automation workflow meets the customer requirements?
A. Extract activity of data view tables > Query activity to create the requiredfile > Transfer activity
B. Report activity that generates Recent Send Summary report > Report delivered directly to FTP
C. Extract activity of Tracking Extracts that combines data into required file > Transfer activity
D. Query activity to pull data view information > Extract activity of data extension > Transfer activity
Answer: D (LEAVE A REPLY)

NEW QUESTION: 88
Northern Trail Outfitters (NTO) is using Einstein Content Selection to populate its emails with
personalized product images at send time. Tnese emails typically see high engagement, but because of
the frequency of these emails, a customer could see the same image asset several times within a 2-
week span.
How should NTO marketers ensure there's a limit to the number of timet a particular image asset can be
chosen for a customer?
A. Set Fatigue Rules for the product Asset Classes.
B. Ask the content team to create more images in order to diversify the asset pool.
C. Utilize Einstein Engagement Frequency to send the emails less often.
D. Set a Fallback Asset.
Answer: B (LEAVE A REPLY)

NEW QUESTION: 89
Northern Trail Outfitters upgraded their Marketing Cloud account which now includes a Sender
Authentication Package (SAP), They send regularly 300,000 What should they be aware of with respect
to sender reputation?
A. They should send at least 250,000 messages per month to maintain their sender reputation.
B. They should have a shared IP since their volume is under 500,000 messages per month.
C. They should have one dedicated IP address for every 100,000 messages send per month.
D. They should have one SAP for transactional sends and another for commercial sends.
Answer: C (LEAVE A REPLY)

NEW QUESTION: 90
A customer wants to automate the send of a monthly promotional email.The customer will upload an
audience file to their account's Enhanced FTP on a monthly basis on the 15th day of each month,
expecting the email to be deployed upon completion of the import activity. However, if the 15th of the
month falls on a Saturday orSunday, the customer will provide the file on the Friday prior to the 15th and
expect the promotional email to be sent on that Friday.
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Given the customer's requirements, which method should be used to automate their monthly
promotional email?
A. Create a scheduled daily automation that includes an import activity and user-initiated send.
B. Create a triggered automation that includes an import activity and user-initiated send.
C. Create a triggered automation that includes an import activity and triggered send.
D. Create a scheduled monthly automation that includes an import activity and triggered send.
Answer: B (LEAVE A REPLY)

NEW QUESTION: 91
Northern Trail Outfitters (NTO) is considering adopting Attribute Groups when incorporating data from
their external systems.
What statements are accurate regarding Attribute Groups?
Choose 2 answers
A. They can contain only one data extension.
B. They link data extensions to other data extensions or contacts.
C. They replicate the structure from the external system data into templates.
D. They can be created by templates to accomplish certain tasks.
Answer: B,D (LEAVE A REPLY)

Valid Marketing-Cloud-Consultant Dumps shared by PrepPdf.com for Helping Passing Marketing-
Cloud-Consultant Exam! PrepPdf.com now offer the newest Marketing-Cloud-Consultant exam
dumps, the PrepPdf.com Marketing-Cloud-Consultant exam questions have been updated and
answers have been corrected get the newest PrepPdf.com Marketing-Cloud-Consultant dumps
with Test Engine here: https://www.preppdf.com/Salesforce/Marketing-Cloud-Consultant-prepaway-

exam-dumps.html (161 Q&As Dumps, 40%OFF Special Discount: Exam-Tests)

NEW QUESTION: 92
What is the skill set you need to build emails with dynamic content?
A. Ampscript
B. SSJS
C. HTML
D. CSS
Answer: A (LEAVE A REPLY)

NEW QUESTION: 93
A customer executes a large number of sends via Marketing Cloud connect and is concerned about API
limits.
What should the consultant suggest to minimize the impact of Marketing Cloud Connect on daily API
limits?
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Choose Two
A. Upgrade the MC account to ConnectedApp
B. Turn off link details tracking
C. Turn off Individual Level Tracking
D. Filter data
Answer: A,C (LEAVE A REPLY)

NEW QUESTION: 94
Northern Trail Outfitters has purchased a new Marketing Cloud account with two dedicated IP
addresses. One IP address will be used for commercial sends, while the other will be reserved for
transactional messages.
Their customer base includes 1.5 million email addresses.
What should the consultant recommend?
A. Split marketing campaigns over a number of days while migrating over smaller triggered campaigns
during the warming period.
B. Focus on warming the IP address for commercial sends, because it is not necessary to warm an IP
address used only for transactional sends.
C. Send to unengaged subscribers during the first two weeks of IP warming in order to give them the
opportunity to interact.
D. Suppress sends to AOL email addresses during the first two weeks of IP warming, then resume
sending to them during the third week.
Answer: A (LEAVE A REPLY)

NEW QUESTION: 95
Northern Trail Outfitters (NTO) is migrating from a series of local legacy email automation tools to a
single global Marketing Cloud instance to leverage its multi-channels abilities as well as native
Salesforce Connector to their global Sales Cloud instance.
Which three factors Should be considered before finalizing the number of business unit they need to
purchase?
(Choose 3 answers)
A. Number of brands/geographies which NTO operates
B. Number of Sales Cloud sandboxes
C. If testing/development business unit($) is required
D. If data/content needs to be segregated between brands/geographies
E. Number of Marketing Cloud users.
Answer: (SHOW ANSWER)
Explanation
The number of business units that NTO needs to purchase depends on several factors, such as the
number of brands or geographies they operate, the need for data or content segregation between them,
and the number of Marketing Cloud users they have or plan to have. These factors affect the
complexity, scalability, and cost of their account hierarchy and governance. The number of Sales Cloud
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sandboxes or testing/development business units are not directly related to the number of business
units they need to purchase, but rather to their testing and deployment strategy. References:
https://help.salesforce.com/articleView?id=sf.mc_overview_business_units.htm&type=5
https://help.salesforce.com/articleView?
id=sf.mc_co_best_practices_for_creating_a_business_unit_structure.htm

NEW QUESTION: 96
A customer would like to send a quarterly re-engagement email to subscribers who have not opened in
the previous three months. The customer's plans are to:
* Use an existing Paste HTML email for the first send.
* Make only minor changes to the email creative for future sends.
* Use an existing Measure to build the subscriber audience for current and future sends.
* Deploy emails manually for now, but possibly automate in the future.
Which configuration is recommended for the re-engagement email send?
A. User-Initiated Send
B. Automated Send
C. Guided Send
D. Triggered Send
Answer: (SHOW ANSWER)

NEW QUESTION: 97
Northern Trail Outfitters (NTO) plans on sending SMS and push notifications together with emails as
part of a new customer onboarding journey.
What should a consultant recommend as a unique identifier for each subscriber?
A. A common field like Physical Address for Contact Key.
B. A number field such as subscriber's phone number for Contact Key.
C. An email address for Contact Key.
D. A GUID or another generated ID for Contact Key.
Answer: D (LEAVE A REPLY)
Explanation
To send SMS and push notifications together with emails as part of a new customer onboarding journey,
Northern Trail Outfitters should use a GUID or another generated ID for Contact Key. A Contact Key is a
unique identifier for each contact in Marketing Cloud across different channels and platforms. A GUID or
another generated ID is recommended as a Contact Key because it is persistent, consistent, and
channel-agnostic. References:
https://help.salesforce.com/s/articleView?id=sf.mc_co_subscriber_key.htm&type=5

NEW QUESTION: 98
Northern Trail Outfitters has been using Marketing Cloud for one of their brands for the last year and
wants to migrate another brand to their portfolio. The two brands have contrasting target groups and
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identities so they need the emails and landing pages to have different styles that refrain from mentioning
the other brand in any way.
What should be recommended?
A. Create a new business unit for the new brand.
B. Request a second SAP for the existing business unit.
C. Request a Private Domain to be added to the existing business unit.
D. Implement a new SSL Certificate for the new brand.
Answer: (SHOW ANSWER)
Explanation
A Private Domain is an email address that is separate from the main domain and allows for the creation
of campaign-specific email addresses, which can then be used to target distinct audiences. This would
allow Northern Trail Outfitters to create emails and landing pages specific to each brand without having
both brands associated with the same domain, thus preventing any overlap or confusion between the
two. Additionally, a Private Domain can help ensure deliverability and compliance, as it allows for more
granular control over the sending domain.

NEW QUESTION: 99
An entertainment company is hosting events across the country in different venues. They want to use
Contact Builder to feed Journey Builder. Contact who enter a journey will go through a decision split
based on the type of event. The journey will send a series of emails and one of them will contain the
venue details dynamically populated with AMP script. The Company collects the following information:
- Customer data (email address, first name, last name...).
- Event registration (email address, event ID, event name, event type, venue ID...).
- Venue details (venue ID, venue name, venue address...).
- Payment details (email address, event ID, total paid...).
The Company does not want to link everything in Contact Builder.
Which are the two data sources that must be incorporated inside Contact Builder? (Choose two.)
A. Event Registration
B. Payment Details
C. Customer Data
D. Venue Details
Answer: C,D (LEAVE A REPLY)

NEW QUESTION: 100
A large retail group consists of a corporate team and several divisions operating under different brand
names. All plan to share one Marketing Cloud account. Each brand has its own marketing department
and operates independently, with its own creative assets, subscribers, and data structure.
What are the two reasons why the recommended account configuration is one corporate Parent
account, with each brand configured as a separate child Business Unit? Choose 2 answers
A. Email sends can be separated into Tracking folders for each brand.
B. Subscribers can be maintained at the Business Unit level.
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C. Brands can set their own physical address and SAP.
D. User roles can be customized to allow or deny specific permissions.
Answer: B,C (LEAVE A REPLY)

NEW QUESTION: 101
Northern Trail Outfitters (NTO) account will be used for email communications with its clients and
employees. They want to send from two different subdomains, so they have delegated e.nto.com as
their SAP domain and mail.nto.com as an additional Private Domain.
Which statement describes how this will impact the account?
A. Links within emails will be wrapped with e.nto.com, but images within Content Builder will use
mail.nto.com.
B. Links within emails will be wrapped with the same subdomain used for the From Address within the
Sender Profile.
C. Links within emails will be wrapped with e.nto.com, and images within Content Builder will use
e.nto.com
D. Links within emails will be wrapped with mail.nto.com, nut images within Content Builder will use
e.nto.com.
Answer: C (LEAVE A REPLY)

NEW QUESTION: 102
Northern Trail Outfitters wants to send special discount offer to engaged customers on their email list.
What should be resolved prior to generating the audience?
A.Who the offer come from
B.When to send the email
C.What the offer will be
D. How to determine engagement
Answer: C (LEAVE A REPLY)

NEW QUESTION: 103
A university plans to use Journey Builder to improve their 1:1 marketing to potential students, current
students, and alumni. The university currently has student data in the Sales Cloud. Other data, such as
course catalog, student demographics, and alumni information, is stored in external systems.
Which two actions should the Consultant recommend? (Choose two.)
A. Use Data Designer to link student and alumni data to the contact record.
B. Use Synchronized Data Sources to obtain data from the Sales Cloud.
C. Create an Import Activity to import alumni data into Salesforce Report.
D. Create list attributes to store student data from the Sales Cloud.
Answer: (SHOW ANSWER)
Explanation/Reference:

NEW QUESTION: 104
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A financial company wants to use Marketing Cloud to send late payment notices to accounts whose
payment due date lapsed the previous week. The company has shared the following:
* Payments.csv will arrive on the Enhanced SFTP each Monday at 1 a.m.
* Payments.csv will be encrypted.
* Payments.csv will contain data from the previous week.
* Late payment notices will be sent each Monday at noon.
* They need to receive a file containing customers who opened or clicked on the late payment notice
email within five days after send.
Which automation sequence represents a viable solution?
A. File Transfer > Import File > Filter > Wait > Send Email > Wait > SQL Query > Data Extract > File
Transfer
B. Import File > File Transfer > SQL Query > Wait > Send Email > Wait > SQL Query > Data Extract >
File Transfer
C. File Transfer > Import File > Filter > Wait > Send Email > SQL Query > Wait > Data Extract > File
Transfer
D. File Transfer > File Transfer > Import File > SQL Query > Wait > Send Email > SQL Query > File
Transfer
Answer: B (LEAVE A REPLY)
Explanation/Reference:

NEW QUESTION: 105
Northern Trail Outfitters wants to export a data file to its SFTP using Automation Studio. The file should
contain all subscribers who did not receive their intended email in the last 24 hours. The automation will
be scheduled to run each day.
Which activity Is required in the automation?
A. Report Definition Activity
B. SendLog Extract
C. Data Extract Activity
D. SQL Query Activity
Answer: C (LEAVE A REPLY)
Explanation
To export a data file to its SFTP containing all subscribers who did not receive their intended email in
the last
24 hours, Northern Trail Outfitters should use a Data Extract Activity in their automation. A Data Extract
Activity is an activity that allows marketers to extract data from Marketing Cloud and place it in a file on
an Enhanced FTP location or an external SFTP location. The Data Extract Activity can use different
extract types, such as Tracking Extract or Data Extension Extract, to export different types of data.
References:
https://help.salesforce.com/s/articleView?id=sf.mc_as_data_extract_activity.htm&type=5

NEW QUESTION: 106
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When Northern Trail Outfitters acquires a new customer, it would like to send a series of welcome
messages on behalf of the brand with an optimized send time. New customers will be sent to Marketing
Cloud via an hourly batch file drop.
Which solution should the consultant recommend?
A. Use Journey Builder to process and segment the new customers, and for the campaign sends and
decisioning.
B. Use Automation Studio to process and segment the new customers, and use Journey Builder for the
campaign sends and decisioning.
C. Use Automation Studio to process and segment the new customers, and use Email Studio for the
campaign sends and decisioning.
D. Use Automation Studio to process and segment the new customers, and for the campaign sends and
decisioning.
Answer: D (LEAVE A REPLY)
Explanation
Automation Studio is a powerful tool that can process and segment data from a variety of sources,
including hourly batch file drops from Marketing Cloud. Once the data is processed and segmented,
Automation Studio can then be used to trigger sends and decisions for campaigns. This allows for a
more efficient workflow and better control over the customer journey. Additionally, Automation Studio
can be used to trigger automated, personalized emails and messages, as well as to monitor the
performance of campaigns and analyze results.
References: Salesforce Certified Marketing Cloud Consultant Exam Study
Guide,
https://trailhead.salesforce.com/en/content/learn/modules/marketing_cloud_consultant_exam_guide/mark

Valid Marketing-Cloud-Consultant Dumps shared by PrepPdf.com for Helping Passing Marketing-
Cloud-Consultant Exam! PrepPdf.com now offer the newest Marketing-Cloud-Consultant exam
dumps, the PrepPdf.com Marketing-Cloud-Consultant exam questions have been updated and
answers have been corrected get the newest PrepPdf.com Marketing-Cloud-Consultant dumps
with Test Engine here: https://www.preppdf.com/Salesforce/Marketing-Cloud-Consultant-prepaway-

exam-dumps.html (161 Q&As Dumps, 40%OFF Special Discount: Exam-Tests)

NEW QUESTION: 107
A customer wants to create a mobile app that requires users to log in or register before accessing their
data.
Their source of truth Is Sales Cloud which Is connected to Marketing Cloud. Users who log In with
existing credentials will have their device associated with their ContactKey. Users who register with the
mobile app will not have their devices associated with a ContactKey for up to 24 hours.
What consideration should a consultant provide to the customer?
A. User device data is unavailable in Contact Builder for up to 48 hours.
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B. Existing users will create additional Contacts in Marketing Cloud.
C. Newly registered users will create additional Contacts in Marketing Cloud.
D. All mobile app users will create additional Contacts in Marketing Cloud.
Answer: (SHOW ANSWER)

NEW QUESTION: 108
The Corporate Apparel Division of ABC Company is moving to Marketing Cloud and will be using ABC
existing account. The Corporate Apparel team has asked for a recommendation on whether they should
have a separate business unit.
Which consideration warrants the creation of a separate business unit for Corporate Apparels instance
of Marketing Cloud?
A. Branding for the Corporate Apparel is different from ABC Company.
B. Managing Unsubscribes for the Corporate Apparel Division only.
C. Sending from a separate IP Address and Domain.
D. Using different From Name and Email Address settings.
Answer: B (LEAVE A REPLY)

NEW QUESTION: 109
Which two statements about a database of record are correct?
Choose 2 answers:
A. A database of record is any database that contains subscriber data
B. A database of recordis a centralized storage repository of data about objects or people
C. A database of record is system in which subscriber's status is maintained
D. A database of record is a data structure in which multiple opt-in statuses can be stored for a
subscriber
Answer: B,C (LEAVE A REPLY)

NEW QUESTION: 110
Northern Trail Outfitters recently purchased Marketing Cloud to start running cross-channel campaigns.
They are looking for guidance on which value to use as the subscriber key.
Which two options should the consultant recommend? (Choose 2 answers)
A. Email
B. CRM ID
C. Mobile Device ID
D. Loyalty Program Number
Answer: B,D (LEAVE A REPLY)
Explanation
To choose a subscriber key for Marketing Cloud, Northern Trail Outfitters should use a value that is
unique, persistent, and channel-agnostic. A CRM ID or a loyalty program number are both good options,
as they meet these criteria and can be used to identify and track subscribers across different channels
and platforms. Email and mobile device ID are not good options, as they are not unique or persistent
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(subscribers can change their email or device) and they are specific to one channel (email or mobile).
References:
https://help.salesforce.com/s/articleView?id=sf.mc_co_subscriber_key.htm&type=5

NEW QUESTION: 111
How do you use data designer to link the web analytics data to your subscriber data?
A. Use a marketing cloud data extension
Answer: A (LEAVE A REPLY)

NEW QUESTION: 112
A customer has an eCommerce site and Imports data into three data extensions daily; 'Orders',
'Order_Details' and 'Products'
the data extension contains the following information:
* Orders: OrderId, CustomerId, OrderNumber, OrderDate, OrderTotal, GrandTotal
* Order_Details: ProductId, OrderId, Qty, UnitPrice, ExtendedPrice, Discount
* Products: ProductId, SKU, Name, Description, Cost, Price
What two actions should be taken in Data Designer?
A. Create a one-to-many relationship between Orders and Order_Details
B. Create a one-to-one relationship between Orders and order_Details
C. Create a one-to-one relationship between Order_Details and Products
D. Create a one-to-one relationship between the contact record and Order_Details
Answer: (SHOW ANSWER)

NEW QUESTION: 113
A customer manually imports records for sending. Each record contains a warehouse ID that is shared
between Marketing Cloud and a third-party system. The customer does not have developer resources,
but wants to include the warehouse ID in their tracking parameters so that the third-party system can
identify the subscriber.
What should a consultant recommend?
A. Use AMPscript variables created from each field in the data extension.
B. Use Dynamic Content rules to select a content area for each subscriber.
C. Use personalization strings created by selecting the data extension.
D. Use Guide Template Language created for each field in the data extension.
Answer: (SHOW ANSWER)

NEW QUESTION: 114
A customer has an eCommerce site and Imports data into three data extensions daily; 'Orders',
'Order_Details' and 'Products' the data extension contains the following information:
* Orders: OrderId, CustomerId, OrderNumber, OrderDate, OrderTotal, GrandTotal
* Order_Details: ProductId, OrderId, Qty, UnitPrice, ExtendedPrice, Discount
* Products: ProductId, SKU, Name, Description, Cost, Price
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What two actions should be taken in Data Designer?
A. Create a one-to-one relationship between Orders and order_Details
B. Create a one-to-one relationship between Order_Details and Products
C. Create a one-to-many relationship between Orders and Order_Details
D. Create a one-to-one relationship between the contact record and Order_Details
Answer: B,C (LEAVE A REPLY)

NEW QUESTION: 115
Northern Trail Outfitters (NTO) uses Marketing Cloud to connect with its individual consumers, retailers
and wholesale buyers, and its corporate apparel customers. Marketing Cloud is currently configured
with data extensions containing Store, Order, Product, and Contact information. NTO is in the process
of implementing Data Designer and linking its data extensions.
How should consumers, retailers, and wholesale buyers be defined in Data Designer?
A. One-to-One Relationship
B. One-to-Many Relationship
C. Population
D. Many-to-Many Relationship
Answer: A (LEAVE A REPLY)

NEW QUESTION: 116
Northern Trail Outfitters wants to build an abandoned cart journey which includes a Decision Split that
evaluates if a customer has made a purchase after they enter the journey. Customer data is stored in a
master data extension ans purchase data is stored in a second data extension.
Which two steps should they include to accomplish this journey?
A. Utilize Entry Data on a Decision Split within Journey Builder.
B. Use Data Designer in Contact Builder to relate the two data extensions.
C. Create a Data Relationship in Email Studio to relate the two data extensions.
D. Configure activities within Automation Studio to update the purchase data.
Answer: (SHOW ANSWER)

NEW QUESTION: 117
Northern Trail Outfitters (NTO) stores customer purchase data m an external system. NTO ingests this
data into Marketing Cloud through a file drop automation. The automation contains an import activity
which overwrites a staging data extension, as well as an SQL Query activity which brings this data into a
sendable data extension.
NTO's marketing manager wants to be informed If mort than 1,000 records are ever imported through
this automation, and would also like to prevent the sendable date extension from being updated that
day.
Which solution ts appropriate in this situation?
A. Split the existing activities into two separate automations.
B. Implement a Wait Activity to wait until the data extension is populated with records.
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C. Place a Verification Activity between the import and SQL Query activity.
D.Write a custom SSJS script to
E. validate the row count of the staging data extension and send a notification email.
Answer: C (LEAVE A REPLY)
Explanation
To inform NTO's marketing manager if more than 1,000 records are ever imported through this
automation, and prevent the sendable data extension from being updated that day, the consultant
should place a Verification Activity between the import and SQL Query activity. A Verification Activity is
an activity that allows marketers to verify if certain conditions are met before proceeding with the next
activity in an automation. For example, a Verification Activity can check if the number of records in a
data extension is above or below a specified threshold, and send an email notification or stop the
automation based on the result.
References: https://help.salesforce.com/s/articleView?id=sf.mc_as_verification_activity.htm&type=5

NEW QUESTION: 118
A customer wants Sales Cloud users to create and send Marketing Cloud emails.
Which two recommendations should the consultant make? (Choose two.)
A. Each Sales Cloud user should have a System Administrator Profile and a Role at the top of the Role
Hierarchy.
B. The consultant should enable deep linking in Marketing Cloud Connect configuration.
C. Each user should have a one-to-one relationship between the Marketing Cloud user and the Sales
Cloud user.
D. The consultant should enable the Create Email feature on the user Profile in Sales Cloud.
Answer: (SHOW ANSWER)
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